User’s Manual

University of North Alabama
Version 1.2
May 29, 2012

MY CASCADE SERVER INFORMATION

URL: http://nabcms.beacontec.com/

Username: 

Initial Password: 

SUPPORT

cs@beacontechnologies.com
336.232.5699

beacontechnologies.com
A. **TABLE OF CONTENTS**

B. **REVISION HISTORY** .............................................................................................................. 4

1. **BASICS** ................................................................................................................................. 5
   1.1. **ABOUT THIS USER’S MANUAL** ..................................................................................... 5
   1.2. **CASCADE SERVER SYSTEM REQUIREMENTS** ................................................................. 5
   1.3. **LOG IN AND OUT** .......................................................................................................... 5
   1.4. **CHANGE YOUR PASSWORD** ........................................................................................... 6
   1.5. **ONLINE HELP** .............................................................................................................. 6
   1.6. **BOOKMARK / SHARE ASSETS** ....................................................................................... 6
   1.7. **QUICK LINKS** .............................................................................................................. 6
   1.8. **MULTIPLE SITES** .......................................................................................................... 6
      1.8.1. **Change Sites** ........................................................................................................... 6
      1.8.2. **Cross-Site Linking and Asset Sharing** ...................................................................... 6
   1.9. **TOP NAVIGATION MENU** ............................................................................................ 6
   1.10. **ASSET TREE** .............................................................................................................. 7
      1.10.1. **Icon Definitions** ...................................................................................................... 7
      1.10.2. **Open / Close Folders** ............................................................................................. 7
      1.10.3. **Context Menu** ....................................................................................................... 7
   1.11. **DASHBOARD / HOME AREA** ....................................................................................... 7
   1.12. **VIEW AN ASSET** ......................................................................................................... 8
   1.13. **ASSET ACTION TOOLBAR** .......................................................................................... 8

2. **EDIT A PAGE** ......................................................................................................................... 9
   2.1. **PAGE TITLES** ............................................................................................................... 9
   2.2. **THE CONTENT EDITOR** ................................................................................................ 9
      2.2.1. **Helpful Tips** ............................................................................................................ 9
      2.2.2. **Copying & Pasting From an External Source** ............................................................. 10
   2.3. **IMAGES** .......................................................................................................................... 10
      2.3.1. **Internal** .................................................................................................................... 10
      2.3.2. **External** ................................................................................................................... 11
      2.3.3. **Upload an Image** ..................................................................................................... 12
   2.4. **LINKS** ........................................................................................................................... 12
      2.4.1. **Link to Page** .............................................................................................................. 12
      2.4.2. **Link to File** .............................................................................................................. 13
      2.4.3. **Link to External Web Site** .......................................................................................... 13
      2.4.4. **Link to Email Address** ............................................................................................ 14
      2.4.5. **Create Anchor Links** ............................................................................................... 15
   2.5. **EMBED MEDIA** .............................................................................................................. 15
   2.6. **HTML EDITING** ............................................................................................................ 16
   2.7. **TABLES** .......................................................................................................................... 16
      2.7.1. **Advanced Options** .................................................................................................... 17
      2.7.2. **Edit Rows and Columns** .......................................................................................... 17
   2.8. **ADVANCED OPTIONS** ................................................................................................... 17
   2.9. **METADATA** ..................................................................................................................... 18
   2.10. **SYSTEM INFORMATION** ............................................................................................. 18
   2.11. **SAVE YOUR PAGE** ...................................................................................................... 19
      2.11.1. **Save as Draft** .......................................................................................................... 19
      2.11.2. **Save as a Final Copy** .............................................................................................. 19
11. USABILITY GUIDELINES................................................................................................................. 38
12. STANDARD PAGE FEATURES......................................................................................................... 39
   12.1. INLINE METADATA .............................................................................................................. 39
   12.2. CONTENT ............................................................................................................................. 39
      12.2.1. Maximum Image Width .............................................................................................. 39
      12.2.2. Maximum Table Width .............................................................................................. 39
   12.3. IMPACT IMAGE .................................................................................................................. 40
   12.4. LEFT COLUMN (CONTACT INFORMATION) ...................................................................... 40
      12.4.1. Set Section’s Default Content .................................................................................... 41
      12.4.2. Change Subsection’s Content .................................................................................... 41
      12.4.3. Hide Content .............................................................................................................. 41
   12.5. RIGHT COLUMN .................................................................................................................. 41
13. FACULTY PROFILES ..................................................................................................................... 42
   13.1. ADD A PROFILE ................................................................................................................ 43
   13.2. EDIT A PROFILE ................................................................................................................. 43
   13.3. DELETE A PROFILE ......................................................................................................... 43
   13.4. MAINTAIN DEPARTMENTS DROPDOWN MENU (ADMINISTRATORS ONLY) .................. 44
      13.4.1. Add a Department ....................................................................................................... 44
      13.4.2. Edit / Delete a Department ....................................................................................... 45
14. TOP-LEVEL FOLDERS (ADMINISTRATORS ONLY) ....................................................................... 45
15. HEADER / FOOTER (ADMINISTRATORS ONLY) ............................................................................ 46
   15.1. HEADER ............................................................................................................................ 46
      15.1.1. Add a Department ....................................................................................................... 46
      15.1.2. Edit / Delete a Department ....................................................................................... 47
   15.2. FOOTER ............................................................................................................................ 47
### B. Revision History

<table>
<thead>
<tr>
<th>Name</th>
<th>Date</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>J. Klingman</td>
<td>05/14/2012</td>
<td>Original Version (1.0)</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>05/21/2012</td>
<td>Updated to Version 1.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Changed Section 12.4, “Left Column”, to allow for multiple contacts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Changed Section 15, “Header / Footer”: both are now include files</td>
</tr>
<tr>
<td>J. Klingman</td>
<td>05/29/2012</td>
<td>Updated to Version 1.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Changed Section 15, “Header / Footer”: split header into multiple include files</td>
</tr>
</tbody>
</table>
1. **BASICS**

1.1. **About This User’s Manual**

This manual is organized to provide you with helpful information about using the software. In order to provide our clients with the most helpful information, only relevant topics are covered in this manual. If you have a question about any feature not covered in this manual, please do not hesitate to contact us. This manual assumes that:

- You have a basic understanding of your computing environment and that you are familiar with common file options such as open, close, and save files.
- You are able to use the Internet and have experience using a web browser.
- Also, it is assumed that the user is knowledgeable in basic image formatting for use on the Web.
- The user has a good understanding of Microsoft Word© and its functions.

1.2. **Cascade Server System Requirements**

You can access Cascade Server to update your site from anywhere you have access to the Internet. Your computer will need to meet or exceed the following software requirements:

- **Web Browser:**
  - Internet Explorer 7+
  - Firefox 3.6+
  - Safari 3+
  - Chrome
- Screen resolution of 1024 x 768 or higher
- Network connection
- Pop-up Blockers: Cascade Server relies heavily on the use of pop-up windows. You will need to configure your pop-up blocker to allow all pop-ups from this site (http://nabcms.beacontec.com/).

1.3. **Log In and Out**

Each person using the software needs a username and password to access the system. For security purposes, inactive users will automatically be logged off after a period of time. Users should log off when not using the system.

**To Log In:**

1. In your browser, go to [http://nabcms.beacontec.com/](http://nabcms.beacontec.com/) (bookmark this page).

2. Enter your **Username** and your **Password**.

3. If you wish for the system to automatically log you in next time, check “Remember me”. Note that for this to work, you should not click “Logout”; otherwise, you will need to log in next time. Note that the system will remember you for two weeks.

4. Click **Login**.

**To Log Out:** Select the **Logout** hyperlink in either the upper right-hand corner or the bottom right-hand corner.
1.4. **Change Your Password**

1. In the upper right-hand corner navigation, click **My Settings**.

2. In the “Change Password” section, type in your new password (twice), and then click **Submit**.
   
   **NOTE:** Your password is case-sensitive.

1.5. **Online Help**

At any time, you may access the Online Help section by clicking on the “Help” link in the upper right-hand corner.

**NOTE:** This online help is provided by Hannon Hill, and not Beacon Technologies.

1.6. **Bookmark / Share Assets**

Cascade Server allows you to bookmark any asset in your browser for easy editing. Just navigate to the desired asset, and bookmark that page. You can also email the URL of an asset. This is useful if you would like another colleague to review a page within Cascade Server. Simply copy the URL of the desired asset and paste into an email. Please note that the recipient will be required to log into Cascade Server in order to view the asset.

1.7. **Quick Links**

A menu containing links to frequently-used tools in Cascade Server can be found in the upper right-hand corner navigation by clicking on **Quick Links**. A menu will pull down containing links to Dashboard items (see Section 1.11 below) and your recent history (for the current session only).

1.8. **Multiple Sites**

**NOTE:** This section is only applicable to users who have access to two or more sites in Cascade Server.

1.8.1. **Change Sites**

You can switch sites by using the Site Selection Menu at the top of the screen.

1.8.2. **Cross-Site Linking and Asset Sharing**

With multiple sites in Cascade Server, you can create links between sites, as well as call (share) assets from other sites. When inserting an image or link, use the Site Selection Menu at the top of the asset selection popup window to select an asset from another site. Inserting images and links will be covered in Section 2.3.

1.9. **Top Navigation Menu**

The top navigation menu is in the blue area at the top of your browser. To navigate the top navigation menu sections, click on the item. If the menu option has a double arrow, a drop down menu of options for that section will appear. You must then select the appropriate option. Each menu option will be covered in later sections of this manual.
1.10. Asset Tree

A tree of assets and folders may be explored in the left navigation frame. This area functions similarly to Windows Explorer.

1.10.1. Icon Definitions

Each icon represents a different kind of asset in Cascade Server, defined below:

- Folder
- Page
- File (Images, PDFs, Office Documents, etc.)
- Navigation Link (select sites only)
- External Link (select sites only)

1.10.2. Open / Close Folders

There are two ways to open and close folders:

1. Click on the folder icon or name to fully open the folder and view details in the right column.
2. Click on the icon to quickly open the folder.
3. To close a folder, click on the folder’s icon.

1.10.3. Context Menu

Each asset in the asset tree has a menu containing common actions for that type of asset, such as Edit, Publish, etc. To view the Context Menu for an asset, simply mouse over the asset, and then click on the arrow that appears (see the screenshot to the right). Then click on the desired action for that asset.

1.11. Dashboard / Home Area

Upon logging in, every user is greeted with a personalized dashboard showing messages, current workflows, assets checked out, and much more general information. The Dashboard, also referred to as the Home Area, is used to supply the user with a summary of the activities that require user attention.
There are five relevant tabs on the home page:

- **Dashboard**: The Dashboard lists a summary of the information on the other four tabs.
- **Messages**: Shows you any messages waiting for you. You will find publish confirmation messages in this area.
- **Workflows**: Shows you any assets that are waiting for an action from you in a workflow.
- **Drafts**: This tab shows you any assets you currently have saved in Draft mode. See Section 2.11.1 below for more information.
- **Recycle Bin**: When deleting assets, they will be put into the Recycle Bin. See Section 10 below for more information.

The dashboard can be accessed at any time by selecting **Home** in the upper left-hand corner.

### 1.12. View an Asset

In order to browse your site, simply click on the desired folder on the left side to expand the folder tree. Once the folder expands, the sub-folders and assets are displayed in the same directory structure that exists when published. Clicking on a page in the folder such as index will bring up a preview of that page in the right frame, just as it would appear online.

### 1.13. Asset Action Toolbar

The Asset Action Toolbar is displayed when editing an asset. Each function will be covered in more detail later.

**View:** Shows the design view of the page.
- Layout: Shows the layout of the page within Cascade Server.
- Preview: Shows the page as it will look once published.
- Live: Shows the corresponding page on your live Web site. Clicking this link allows you to view a page that you just published without having to leave Cascade Server.
- Properties: Shows information for the current page.
- Configurations: Shows the file structure of the page. Users should ignore this option.

**Edit:** Start editing the page’s content and metadata. Clicking this will start the editor. See Section 2.
- Content: The area where you edit your content.
- Metadata: Edits search engine metadata, such as keywords and descriptions.
- System: Toggle whether this asset should be published or indexed.
- Configurations: Shows the page’s regions. Users should ignore this option.

**Move/Rename:** Move this asset to another folder, or change the name of this asset. See Section 7.4.

**Copy:** Copies the current page and its contents to a specified location. See Section 7.3.

**Publish:** Used to move your pages out to your Web site. See Section 3.

**More:** Clicking this will show a drop-down menu containing more options. The most notable is “Delete” (Section 7.5) and “Versions” (Section 9), which allows a user to restore a previous version of the current page.
2. **EDIT A PAGE**

When editing a page, you can edit your content, change the name of a page, change page titles, and maintain metadata keywords and descriptions for search engines. You can create links to internal pages and external sites, insert images, create tables, and much more.

To start editing a page, click on the desired page in the left Asset Tree, and then click the **Edit** tab in the Asset Action Toolbar.

2.1. **Page Titles**

This feature gives you the ability to control the titles of a page, both what is displayed in the content area, and what is displayed in the site’s navigation.

The Display Name and Title fields are located at the top of the page when in Edit. There are two fields for maintaining this information, located in the “Inline Metadata” section:

- **Display Name:** The shortened title of your page. This is the title that is displayed in your navigation menus. **NOTE:** If you do not want a page to be displayed in the navigational scheme, see Section 8.3 below.

- **Title:** A longer version of the display name. It is often used for the page heading and title bar of the browser. This can be the same as the Display Name field.

2.2. **The Content Editor**

The content editor integrated into Cascade Server has the same functionality and features you are most likely accustomed to using in a standard editor, such as Microsoft Word®. The advanced features of the editor are explained in the next sections. Mouse over each icon in the editor toolbar to see its description, or see a full explanation here.

To insert/edit content, simply type in your text, or paste from an external source, just as you would in a standard word processor.

2.2.1. **Helpful Tips**

- Press the “Enter” key for a double-spaced line. To make a single-spaced line, hold “Shift” while pressing Enter.

- You can open the editor in full screen mode to make it easier to edit large amounts of content. To do this, click the “Full Screen” button  . To close the full screen mode, click the  button again.
2.2.2. Copying & Pasting From an External Source

If you copy and paste your text from an external source (such as Microsoft Word), Cascade Server will attempt to clean up the source document’s formatting in order to display your content in your Web site’s default font.

If this does not work properly, select all text in the editor, and then click the “Remove Formatting” button . Doing so should remove any undesired formatting copied over from your source document. This will allow your site to maintain a consistent font type, size, and color.

If this step does not work, before pasting your content into the editor, click the “Paste as Plain Text” button in the toolbar, and then paste. This will bring in all of your content in plain text with no formatting. Alternatively, you can paste your content into Notepad, and then copy and paste from there.

2.3. Images

You can either insert an image that has been uploaded into Cascade Server, or point to an image that exists on another Web site. Also in this section, you can upload an image while editing the page.

⚠️ NOTES:

- The maximum width for any image inserted into the editor is 470 or 705 pixels. There is no restriction on height.
- For best results, any image that is used in your content should be properly sized before inserting into your content area. You can upload and edit an image using Cascade Server’s image editor. See Section 7.2 below.
- For advanced image editing not covered by the Cascade Server image editor, use a graphics program before uploading the image into Cascade Server.

2.3.1. Internal

An “Internal” image is defined as an image that already resides in Cascade Server. This means that any image you want to insert into your content must first be uploaded into Cascade Server. To upload an image, see Section 2.3.3 below.

Once your image is in Cascade Server, follow the instructions below to insert the image into your content.

1. Place your mouse cursor in your content where you want the image to appear.

2. Click on the Insert/edit Image icon in the toolbar. A pop-up window will appear (see the screenshot to the right).

3. Select your image by doing the following:
   a. In the “Image” field, click the browse icon. Another window will open, and you will see your folder tree on the left side.
   b. Click on the appropriate folders until you find the folder which contains your image.
   c. Click on the desired image file. A preview of the image will appear to the right.
   d. Click Confirm. The “Image” field will be filled in with the selected image file path.
4. The “Alternate Text” field is the text that will display when a user mouses over the image (also known as the “ALT Tag”). This is also necessary for screen readers used by the visually impaired. Type in a short, meaningful description for the image.  

   ▶️NOTE: This field is required.

5. **Do not enter any values for Width/Height.** We recommend resizing your image using the instructions in Section 7.2 below, and not using these fields.

6. There are several advanced attributes for an image. Click on the **Advanced** tab at the top of the window:

   - **Alignment:** Sets the alignment of your image in relation to your content. For instance, “Default” means you can place the image anywhere on the page and it will be inline with your text. If you want the image on the right side of the page and the text to wrap around it, select “Right”. These options function the same as Microsoft Word.

   - **Border Width:** Places a border around your image.  
     
     ▶️NOTE: We recommend adding a border to your image with a graphics program, and not using this field.

   - **Vertical Spacing:** The number of pixels of padding around the top and bottom of your image.  
     
     ▶️NOTE: We recommend using a value of at least “5” for best usability practices.

   - **Horizontal Spacing:** The number of pixels of padding around the left and right of your image.  
     
     ▶️NOTE: We recommend using a value of at least “5” for best usability practices.

7. Click the **Insert** button. The window will close, and your image will be inserted into the content.

8. If you need to modify your image, simply click on your image, and then click on the **Insert/edit Image** icon in the toolbar again. To move your image within the content area, click and drag the image to the desired location.

### 2.3.2. External

An “External” image is defined as an image that exists on another Web site. This means that every time someone views your Web page, the image will be called from the specified external Web site.

To link to an external image, you will need the full Web address (URL) for the image. Then do the following:

1. Place your mouse cursor in the area desired for the image within your content.

2. Click on the **Insert/edit Image** icon in the toolbar. A pop-up window will appear.

3. At the top of the popup window, select the **External** radio button.

4. In the “Image” field, type the exact Web address (URL) of the image you wish to link to. For example, http://www.beacontechnologies.com/images/logo.gif.  

   ▶️NOTE: Ensure that your link starts with **http://**. Otherwise, the image will be broken.

5. Follow Steps 4-8 in Section 2.3.1 above.
2.3.3. Upload an Image

If your desired image is not loaded into Cascade Server, you can upload the image by doing the following from the Insert/Edit Image dialog box:

1. Follow the instructions in Steps 1-2 in Section 2.3.1 above.

2. In the “Image” field, click the browse icon  . Another window will open, and you will see your folder tree on the left side.

3. In the asset tree on the left, click on the folder you wish to upload the image into.

4. Click on **Upload** in the top blue bar (see image to the right).

5. Click the **Browse** button to locate the image file on your hard drive or network drive.

6. Click **Upload**. Your image will be uploaded into the system and displayed.

7. Click **Confirm** to select the uploaded image. The window will close, and your image will be listed in the “Image” section.

8. Follow Steps 4-8 in Section 2.3.1 above.

⚠️ **NOTE:** You can also upload an image using Section 7.1.1 below.

2.4. Links

With Cascade Server, you have the ability to make text or an image link to a page, a file (PDF, etc.), or an external Web site. Also, you can link to a person’s email address, or add an anchor link in order to jump to a section within your page.

2.4.1. Link to Page

This section explains how to link to a page that already resides in Cascade Server.

⚠️ **NOTE:** To create a page, see Section 4 below.

1. Highlight the word(s) or click on the image you wish to make a link, and then click the **Insert/edit Link** icon  in the toolbar. A pop-up window will appear.

2. In the “Link” field, click the **Browse** icon  . Another window will open, and you will see your Asset Tree on the left side.

3. Find the page you want to link to by clicking through the folders on the asset tree on the left, and then clicking on the desired page (will have an  icon). The path to the selected page will appear on the right side of the window.
4. Click **Confirm**. The “Link” field will show the selected asset’s path.

5. Leave the value in the “Target” field set to “Same Window”.

6. Click **Insert**. The window will close, and your text (or image) will now be a link.  
   \<<NOTE>>: The text or image will not be clickable within the content editor.

7. If you need to modify your link, click on your link text or the image and click the **Insert/edit Link** icon in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the **Unlink** icon in the toolbar.

### 2.4.2. Link to File

This section explains how to link to a file within Cascade Server.  
\<<NOTE>>: To upload a file, see Section 7.1.1 below.

1. Highlight the word(s) or click on the image you wish to make a link, and then click the **Insert/edit Link** icon in the toolbar. A pop-up window will appear.

2. In the “Link” field, click the **Browse** icon. Another window will open, and you will see your Asset Tree on the left side.

3. Find the file you want to link to by clicking through the folders on the asset tree on the left, and then clicking on the desired file (will have an icon). The path to the selected file will appear on the right side of the window.

4. Click **Confirm**. The “Link” field will show the selected asset’s path.

5. In the “Target” field, select “New Window”.

6. Click **Insert**. The window will close, and your text (or image) will now be a link.  
   \<<NOTE>>: The text or image will not be clickable within the content editor.

7. If you need to modify your link, click on your link text or the image and click the **Insert/edit Link** icon in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the **Unlink** icon in the toolbar.

### 2.4.3. Link to External Web Site

This section explains how to link to another Web site.  
\<<NOTE>>: To link to another Web site, you will need the full Web address (URL) for the site.

1. Highlight the word(s) or click on the image you wish to make a link, and then click the **Insert/edit Link** icon in the toolbar. A pop-up window will appear.

2. Click the **External** radio button at the top of the window.
3. In the “Link” field, type in the Web address of the site you wish to link to (e.g. http://www.beacontechnologies.com/).
   \[ \text{\textbf{\textcolor{red}{\textbf{\textit{NOTE:}}}} ensure that your link starts with \textcolor{blue}{http://}. Otherwise, the link will be broken.} \]

4. In the “Target” field, select “New Window”.

5. Click \textbf{Insert}. The window will close, and your text (or image) will now be a link.
   \[ \text{\textbf{\textcolor{red}{\textbf{\textit{NOTE:}}}} The text or image will not be clickable within the content editor.} \]

6. If you need to modify your link, click on your link text or the image and click the \textit{Insert/edit Link} icon \[ \text{\textcolor{red}{\textbf{\textit{[icon]}}} \] in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the \textit{Unlink} icon \[ \text{\textcolor{red}{\textbf{\textit{[icon]}} \] in the toolbar.

\textbf{2.4.4. \textit{Link to Email Address}}

This option makes your link open the user’s default mail program in order to send an email.

1. Highlight the word(s) or click on the image you wish to link to an email address, and then click the \textit{Insert/edit Link} icon \[ \text{\textcolor{red}{\textbf{\textit{[icon]}}} \] on the toolbar.

2. Click the \textbf{External} radio button at the top of the window.

3. In the “Link” field, \textbf{remove} the “http://” that is in the field by default. Then type “mailto:” and then the email address you wish to link to (e.g. pcs@beacontechnologies.com). The field will look like this:

   \[ \text{mailto:pcs@beacontechnologies.com} \]

4. Click \textbf{Insert}. The window will close, and your text (or image) will now be a link that, when clicked, will send an email to the email address you entered in Step 3.
   \[ \text{\textbf{\textcolor{red}{\textbf{\textit{NOTE:}}}} The text or image will not be clickable within the content editor.} \]

5. If you need to modify your link, click on your link text or the image and click the \textit{Insert/edit Link} icon \[ \text{\textcolor{red}{\textbf{\textit{[icon]}}} \] in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the \textit{Unlink} icon \[ \text{\textcolor{red}{\textbf{\textit{[icon]}} \] in the toolbar.
2.4.5. Create Anchor Links

This option allows you to link to a specified point within the current page, or on another page. For instance, if you would like to create a link that “jumps” the user down to another part of your page, you can do so by doing the following:

1. Place your cursor in the content where you wish to make the anchor point (the place where you want the user to “jump” to), and then click the Insert/edit anchor icon.

2. Type the name of your anchor into the “Anchor Name” field. For example, if you are linking to a section called “History”, name your anchor “history”.
   \[\textbf{⚠️ NOTE:}\] Do not put any spaces in your anchor name. Take note of the exact value you are typing in here, which will be used in a later step.

3. Click Insert. The editor places an anchor icon indicating that you have added an anchor.
   \[\textbf{⚠️ NOTE:}\] This icon will not be displayed when published.

4. Highlight the text or click on the image that you wish to link to the anchor that you just created in Step 3, and then click the Insert/edit link icon.

5. If you are linking from another page to this anchor point, select the page you wish to link to in the “Link” field. If you are linking to an anchor point within the current page, skip to Step 6.

6. In the “Anchor” field, type the exact name that you used in Step 2 above.
   \[\textbf{⚠️ NOTE:}\] This value must match the value from Step 2 exactly, including using the same capitalization.

7. Click Insert. The text is now the link to your anchor point.
   \[\textbf{⚠️ NOTE:}\] The text or image will not be clickable within the content editor.

8. If you need to modify your link, simply click on your link text or the image and click the Insert/edit Link icon in the toolbar. If you wish to remove a link, click on your link text or the image, and then click the Unlink icon in the toolbar.

2.5. Embed Media

\[\textbf{⚠️ NOTE:}\] This section is for advanced users only who are familiar with embedding different types of media into a Web page and modifying an embed statement’s advanced attributes.

To insert a media application, such as Flash, visit Hannon Hill’s Knowledge Base instructions here.

\[\textbf{⚠️ NOTE:}\] The maximum width for any media inserted into the editor is 470 or 705 pixels.
2.6. HTML Editing

To edit the HTML for your content, click on the HTML icon in the toolbar. A popup window will appear containing the content’s HTML. Make the desired HTML edits, and then click the Update button at the bottom of the window.

2.7. Tables

Inserting a table into Cascade Server is very similar to Microsoft Word’s insert table wizard. 

⚠️ **NOTE:** The maximum width for any table inserted into the editor is 470 or 705 pixels.

1. Place your cursor in the desired location of your table and click the **Insert a new Table** icon.

2. In the “Rows” and “Cols” fields, type in the number of desired rows and columns.

3. In the “Cellpadding” and “Cellspacing” sections, type in the desired cellpadding and cellspacing. The recommended values are “3” and “0”, respectively.

4. Set the alignment of the table in the “Alignment” menu. “Not set” means you can place the table anywhere on the page, and it will be inline with your text.

5. Set the desired border thickness of your table, measured in pixels. The recommended value is 1.

6. In the “Width” and “Height” fields, type in the desired width and height of the table. This value can be in pixels or percentage (e.g. “100%”).

7. If you would like to have your table to conform to a predetermined table style (if applicable), in the “Class” drop-down, select “table”. This will give your table a standard appearance that other pages use. 

⚠️ **NOTE:** If you do select a “Class”, you must change your “Cellpadding”, “Cellspacing”, and “Border” values to “0” (zero).
2.7.1. Advanced Options

1. Click on the Advanced tab at the top of the window.

2. In the “Summary” field, type in a description of the table that you are inserting. This is required for Section 508 Compliance (if applicable). For example:
   This table contains donations data.

3. If you would like your table’s borders to have a color, click on the chooser icon in the “Border color” field, which will display a selection of colors to choose from. If you have a specific color you would like to use, simply enter the hexadecimal value in the “Border color” field (e.g. #336699).
   **NOTE:** If you selected a class in Section 3.5.1, #7, do not set a value for this field.

4. If you would like your table to have a background color, click on the chooser icon in the “Background color” field, which will display a selection of colors to choose from. If you have a specific color you would like to use, simply enter the hexadecimal value in the “Background color” field (e.g. #336699).
   **NOTE:** If you selected a class in Section 3.5.1, #7, do not set a value for this field.

5. Click the Insert button. This will close the window and display your table within your content.

6. To edit the above values at any time, right-click anywhere in the table, and select Table Properties.

2.7.2. Edit Rows and Columns

To insert or remove columns and rows, or format individual cells, columns, or rows, right-click in the desired column/row/cell to bring up the Table action menu, and select the desired action from the menu. The actions behave just like Microsoft Word and Microsoft Excel.

2.8. Advanced Options

The Advance Options section is located at the bottom of the page, just above the “Submit” button. If the options are not showing, click the “Advanced Options >>” link to display them. Each option is described in detail below:

- **Check Spelling:** Cascade Server will check the spelling of your content when you save the page.

- **Check Accessibility:** Enable this option if you want Cascade Server to verify that your content is accessible for disabled users. Section 508 Compliance ensures that the web content adheres to government standards for content accessibility for persons with disabilities.

- **Check Links:** Cascade Server will check the links on your page to ensure that none are broken.

- **Start Workflow:** Sends this page into a workflow. If this is disabled, you do not have a workflow available.

- **Tidy HTML:** Cleans up any HTML that you may have manually entered. This should remain checked.

- **Version Comments:** You may wish to insert comments here when editing a page. This will aid in tracking your changes for future modifications. For Versions, see Section 4 below.
2.9. Metadata

Metadata, merely data about data, is used for a variety of tasks in Cascade Server, the most common of which is dynamic navigation menus. Common navigation menus include site maps and context navigation (typically on the left navigation or top navigation). This is where you will be able to change page titles and modify keywords and descriptions used by the search engines.

1. To edit the page metadata, click on the Metadata link in the dark blue bar, just below the Asset Action Toolbar.

2. **Keywords**: Relevant keywords about your page that are read by the search engines. For more information on keywords and key phrases, please contact your Beacon Technologies Account Executive.

3. **Description**: The description that is read by the search engines. This should be a short sentence explaining the purpose of your page. For more information on Meta descriptions, please contact your Beacon Technologies Account Executive.

4. **Advanced Options**: See Section 2.8 above.

2.10. System Information

The System Information of a page is the information that Cascade Server uses to identify the page. Features include whether or not the file should be published or indexed, and spelling and Section 508 Accessibility options. The relevant options are listed below.

1. While editing your page, click the **System** link in the Asset Action Toolbar.

2. **Publish**: This will indicate whether your file should publish to your Web site. Uncheck this box to prevent this file from being published. There is rarely a time where you would want to uncheck this box.

3. **Index**: Tells the system whether or not to include this file in the navigation. Unchecking this box will remove this file from all navigational schemes. This is useful if you want to temporarily “turn off” a file and have it not be available to the user, but you want to keep the file in Cascade Server for later use.

4. **Advanced Options**: See Section 7 above.
2.11. Save Your Page

2.11.1. Save as Draft

The “Save as Draft” feature allows you to periodically save drafts of assets that you are editing in order to return later to finish their work. Using the “Save Draft” button will save your work, but your changes will not be committed and saved as a final version until you use the “Submit” button (Section 2.11.2 below).

To use the “Save as Draft” feature:

1. Click the **Save Draft** button, located at the bottom of your page. Your changes will be saved into a Draft mode, and the page will reload. You can now continue working on your page.

2. Once you have saved the draft version, at the bottom of the page, two new buttons will appear:
   - **Update Draft**: Use this button to save your work periodically as you make your changes.
   - **Discard Draft**: Use this button to undo all of your changes.

   **NOTE:** Using this feature will erase all changes made since the last full save of the page. This will not delete the page or any previous versions.

While your page is in Draft mode:

- You can view your changes in the page by clicking the **View** tab in the Asset Action Toolbar. To get back to editing your page, click the **Edit** tab.
- You can see the way the page looked before you started your edits. To do this, click the **View** tab in the Asset Action Toolbar. In the “Viewing” line just below the Asset Action Toolbar, click **Current**. To get back to editing your page, click the **Edit** tab.
- You can navigate away from the page and even log out, and your changes will still be saved in Draft mode for when you return.
- While other users will be able to make their own edits to the page and publish them, those users will not be able to edit or publish your current changes.
- You cannot copy, delete, or publish the page until you save the final copy using Section 2.11.2 below.

2.11.2. Save as a Final Copy

When you are completely done with your changes, you’ll then need to save your page using the **Submit** button.

1. In the “Advanced Options” section, check any desired options and enter any desired comments into the “Comments” field (see Section 2.7.1 above).

2. Click the **Submit** button at the bottom of the page. This will save your page.

**NOTES:**

- This will not publish your page to your Web site. For publishing, see Section 3 below.

- If another user has made changes to the page while you had a draft in-progress, you will receive the following message: “**Another user updated the current version of this asset while you were editing.**” By clicking the **Submit** button, you will overwrite the other user’s changes and save your own changes. By clicking the **Update Draft** button, you will be returned to the editing screen to make additional changes.
3. **Publishing**

One of the many benefits of Cascade Server is that you can modify your Web site within the tool, and your changes are not reflected on your live Web site until you publish your content. If you are a user with the appropriate permissions, you can publish an individual file, multiple files, an entire folder, or the entire site to your live Web site. Listed below are some general points about how publishing works:

- Publishing sends your assets from Cascade Server and moves them to the specified destination. Once you have published, it will take some time (depending on the amount of files that are publishing) to display on your live site.

- A page will publish any images that are in its content area. However, it will not publish other linked pages.

- Upon publishing, you will be taken to the publisher status screen. On this screen, you’ll see the assets that you have published and the system’s current progress, as well as any jobs currently in the queue. If you leave this screen, you can get back to it by selecting the System menu from the blue top navigation bar, then **Publisher**, and then clicking on **Active Jobs**.

- To see a confirmation message stating whether or not your file published successfully, click **Home** on the top navigation bar, and then select the **Messages** tab. The confirmation message will be displayed once the system has finished publishing.

3.1. **Publish a Single Asset**

To publish a single asset (page, file, or folder):

1. In the left asset tree, click on the asset (page, file, or folder) that you want to publish.

2. In the Asset Action Toolbar, select **Publish**. The screen to the right appears.

3. If you are publishing a page, you will see a “Page Configurations” section. Listed will be all available configurations of your page, such as “HTML” (your regular Web site) or “Mobile” (the mobile version of this page). Leave all of these checked in order to publish all configurations of this page. If you do not want to publish a specific configuration of this page, uncheck the appropriate checkbox.

4. In the “Destinations” section, choose which Web sites you want publish to by checking/unchecking the appropriate destination(s).

**NOTES:**

- By default, all of your available destinations will be selected.
- For each destination (Test and Production, for example), depending on what type of asset you are publishing, you may see multiple checkboxes for each destination. In order to publish properly, you must select all available checkboxes for the desired destination.

5. Click **Submit**. Your asset will now publish.
3.2. Publish Multiple Assets

To publish multiple assets at one time:

1. In the navigation tree on the left, select the folder where the assets are located.

2. Check the boxes next to the assets that you want to publish.

3. At the bottom of the file list, in the "With Selected" drop-down menu, select Publish.

4. Click Submit.

⚠️ NOTE: Using this method will not allow you to select which destinations to publish to. You will automatically have to publish to all available destinations (“Test” and “Production”).

3.3. Publish a Folder

Publishing a folder will publish all assets within that folder, including subfolders.

1. In the navigation tree on the left, select the folder you want to publish.

2. In the Asset Action Toolbar, select Publish.

3. In the “Destinations” section, choose which Web sites you want to publish to by checking/unchecking the appropriate destination(s).

⚠️ NOTES:
- By default, all of your available destinations will be selected.
- For each destination (Test and Production), depending on what type of asset you are publishing, you may see multiple checkboxes for each destination. In order to publish properly, you must select all available checkboxes for the desired destination.

4. Click Submit.
3.4. Publish Your Full Site

To publish your entire Web site:

1. In the navigation tree on the left, select the "Base Folder" folder.

2. In the Asset Action Toolbar, select Publish.

3. In the “Destinations” section, choose which Web sites you want publish to by checking/unchecking the appropriate destination(s).

   **NOTES:**
   - By default, all of your available destinations will be selected.
   - For each destination (Test and Production), depending on what type of asset you are publishing, you may see multiple checkboxes for each destination. In order to publish properly, you must select all available checkboxes for the desired destination.

4. Click Submit.

3.5. Un-publish an Asset

With Cascade Server, you have the ability to “un-publish” any asset. Un-publishing will delete an asset from your Web site, but will not remove the file from Cascade Server. To delete an asset from Cascade Server, see Section 7.5 below.

To un-publish an asset:

1. Choose the desired method of publishing above (single asset, multiple assets, or a folder), and click the Publish tab.

2. In the Asset Action Toolbar, select Publish.

3. In the “Destinations” section, choose which Web sites you want publish to by checking/unchecking the appropriate destination(s).

   **NOTES:**
   - By default, all of your available destinations will be selected.
   - For each destination (Test and Production), depending on what type of asset you are publishing, you may see multiple checkboxes for each destination. In order to publish properly, you must select all available checkboxes for the desired destination.

4. In the “Options” section, in the “Publish Mode” section, select the “Un-publish” radio button.

5. Click Submit. The asset will now be un-published.
3.6. Publishing Guidelines

Knowing what you need to publish in order for your site to maintain its structure is critical. You can continue to have a high-quality Web site by using the guidelines listed below. Exceptions to these guidelines for your specific Web site will be covered with you by a Beacon representative.

The below table highlights common changes you will make, and what publishing action you should take.

<table>
<thead>
<tr>
<th>Asset Action</th>
<th>Explanation</th>
<th>Publishing Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Changes to a Page</td>
<td>The changes you made only affect the current page.</td>
<td>Publish Single Asset (Section 3.1)</td>
</tr>
<tr>
<td>Add a Page</td>
<td>The navigation areas have been updated automatically. In order for these navigational changes to appear on all pages that contain that navigation, you will need to publish those affected pages.</td>
<td>Publish All Affected Pages • Folder (Section 3.3) OR • Full Site (Section 4)</td>
</tr>
<tr>
<td>Rename a Page</td>
<td>The navigation areas have been updated automatically. In order for these navigational changes to appear on all pages that contain that navigation, you will need to publish those affected pages.</td>
<td>Publish All Affected Pages • Folder (Section 3.3) OR • Full Site (Section 4)</td>
</tr>
<tr>
<td>Move a Page</td>
<td>The navigation areas have been updated automatically. In order for these navigational changes to appear on all pages that contain that navigation, you will need to publish those affected pages.</td>
<td>Publish All Affected Pages • Folder (Section 3.3) OR • Full Site (Section 4)</td>
</tr>
<tr>
<td>Delete a Page</td>
<td>The navigation areas have been updated automatically. In order for these navigational changes to appear on all pages that contain that navigation, you will need to publish those affected pages.</td>
<td>Publish All Affected Pages • Folder (Section 3.3) OR • Full Site (Section 4)</td>
</tr>
<tr>
<td>Change a Page's Display Name</td>
<td>The navigation areas have been updated automatically. In order for these navigational changes to appear on all pages that contain that navigation, you will need to publish those affected pages.</td>
<td>Publish All Affected Pages • Folder (Section 3.3) OR • Full Site (Section 4)</td>
</tr>
<tr>
<td>Change a Page's Title</td>
<td>The changes you made only affect the current page.</td>
<td>Publish Single Asset (Section 3.1)</td>
</tr>
<tr>
<td>Change a Page's Metadata (keywords and description)</td>
<td>The changes you made only affect the current page.</td>
<td>Publish Single Asset (Section 3.1)</td>
</tr>
<tr>
<td>Sort Assets</td>
<td>The navigation areas have been updated automatically. In order for these navigational changes to appear on all pages that contain that navigation, you will need to publish those affected pages.</td>
<td>Publish All Affected Pages • Folder (Section 3.3) OR • Full Site (Section 4)</td>
</tr>
<tr>
<td>Upload File(s)</td>
<td>The changes you made only affect the current file(s).</td>
<td>Publish Single Asset (Section 3.1) OR Publish Multiple Assets (Section 5 OR Publish Folder (Section 3.3))</td>
</tr>
</tbody>
</table>
4. **CREATE A PAGE**

Creating a new page in Cascade Server is simple. When you add a new page to a main folder (i.e. a folder that is listed as a main category on your Web site), the navigational structure of your site will be automatically updated with the information you provide.

To add a new page:

1. In the left asset tree, click on the folder that you wish to add a new page to.
2. In the blue Top Navigation Menu bar, click **New**, and then click the type of page you wish to add (e.g. “Standard Page”).
3. Verify that the folder listed in the “Parent Folder” (the folder that the page will be created in) field is correct. If it needs to be changed, click on the path and select the correct folder.
4. Click the **Metadata** link in the Asset Action Toolbar and type in any keywords or descriptions that you want (optional).
5. Click the **Content** link in the Asset Action Toolbar.
6. Type in the desired values for the “Display Name” and “Title” for the page. The “Display Name” is the value that will be displayed in your site’s navigation, and the “Title” is the value that will be displayed as the page’s title above your content area.
7. Insert your content into the editor by following the steps listed in Section 2.2 above.
8. Follow the instructions in Section 9 below to sort your new page in the navigation (if applicable), and publish your page using the instructions in Section 3 above.
5. **CREATE A SUBSECTION**

In addition to creating pages within a main section (e.g. “About Us”, “Our Products”, etc.), you may find it necessary to create a subsection within that section. This is useful for housing a related group of pages in one section, making it easier for a site user to navigate your pages. The new subsection will display on the top and left navigation, and the left navigation will expand to show your subsection’s pages.

For example, you want to add a subsection called “Our History” to your main section “About Us”, resulting in “About Us > Our History”. To do this:

1. Navigate to the folder that you wish to add the new subsection to.

2. In the blue Top Navigation Menu bar, click **New**, and then click **Subsection**.

3. Type in a “Display Name” and “Title” for your folder. The “Display Name” will be the value that will be displayed in the navigational structure, and the “Title” will be displayed on your page as subsection’s main title.

4. Click **Submit** to save your new folder.

5. In the left asset folder tree, click on the new folder that was created in Step 4 above.

6. Following the instructions in Section 2 above, edit the “index” page’s Display Name, Title, and Content. **\[NOTE: This page must remain in this folder, and cannot be renamed (it must keep a System Name of “index”) in order for your navigation work properly. This page can contain any Display Name, Title, and content that you wish, and will be the page that a Web site visitor lands on when entering this subsection.**

7. In this new folder, follow the steps in Section 4 above to create your new pages.

8. Click on the subsection’s parent folder (the folder you created in Step 5) in the left asset tree. The parent folder is the main section’s folder (in this case, “about”).

9. Sort your new subsection as desired (see Section 8.2 below for sorting instructions).
6. **FOLDERS**

6.1. **Detail View**

The folder detail view can be seen by clicking on the desired folder in the left asset tree (see the screenshot to the right for an example). The detail view shows all assets in that folder using the following columns:

- **Name:** The asset’s file name.
- **Order:** The order that these assets will appear in the navigation. See Section 7 below.
- **Last Modified:** The date that the asset was last modified.
- **Last Modified By:** The user who last modified the asset.
- **Actions:** Sorting and editing options. This column can be ignored.

6.2. **Add a Folder**

You can add a folder to any part of your Web site to organize images, PDF documents, etc. **NOTE:** To add a folder for the purposes of sorting your navigation, please see Section 5 above to add a subsection.

To add a folder:

1. Select the desired folder in the asset tree on the left that you want to add this new folder into, and then click **New**, and then click **Folder**.

2. Type in the desired folder name into the “System Name” field.

3. Click **Submit**. The folder will be created.

6.3. **Edit a Folder**

You can edit any folder name or title within a major section. For example, you can edit any folder under the “about-us” folder, but not the “about-us” folder itself. Editing a folder would include changing the folder name, Display Name, Title, or the parent folder.

1. Select the desired folder in the asset tree on the left, and then click “Edit”.

2. Make the desired changes to the Display Name, Title, and System Name, and then click **Submit**.
7. **Asset (File) Management**

An asset in Cascade Server is any file within the system: a page, an image, a folder, etc. This section covers the kinds of actions you can perform with these assets, including uploading files, modifying files, using the image editor, and copying, moving, renaming, and deleting assets.

7.1. **Files**

In order to use any files in your content, you will first need to upload them into Cascade Server. You can upload any file type to Cascade Server. You can upload one file at a time, multiple files at once, or edit an existing file.

7.1.1. **Upload a Single File**

1. In the left asset tree, click on the folder that you want to upload your file to.

2. In the top navigation bar, click **New**, and then click **File**.

3. Leave the “System Name” field blank. The system will automatically use the name of the file being uploaded.

4. In the “Data” section, click the **Browse** (or **Choose File** in Chrome) button. A popup window will be displayed, which shows the contents of your hard drive or network drive.

5. Find the file that you want to upload and click on it. Then click the **Open** in the bottom right-hand corner of the window. The window will close.

6. If you are uploading an image, the image will be displayed inside of an image editor. To use the image editor, see Section 7.2 below. If you are uploading anything other than an image, you will not see a preview of the file.

7. Click the **Submit** button at the bottom of the page. The page will reload with your uploaded file, placed into the folder you selected in Step 1. A preview of the file will be displayed on the right.

⚠ **NOTES:**

- The maximum file size that can be uploaded into Cascade Server is **20 MB**.
- While pages should not have an extension on its System Name value, files **must** keep their native file extension (e.g. “.pdf”). Do not remove these extensions from a file’s System Name value.
7.1.2. Upload Multiple Files

If you have multiple files that you would like to upload, you can upload them all at once to save you time. Doing so requires the use of a ZIP program, such as the ZIP program included in Microsoft Windows. You can zip all of your files and directory structure into a single file, upload this file, and Cascade Server will extract your files with the directory structure into your destination folder.

1. Using your ZIP program, zip up all of the files you want to upload. Your file must have a .zip extension.
2. Navigate to the folder that you want to upload your ZIP file to.
3. In the blue top navigation bar, click **Tools**, and then click **Zip Archive**.
4. In the “Zip Archive” field, click the **Browse** button. Locate your ZIP file on your hard drive.
5. Click **Submit**. Your ZIP file will be uploaded, and its contents extracted into your placement folder.

7.1.3. Update a File

Updating a file that is already in the system requires uploading a new version of the file. To update a file that you have already uploaded:

1. In the left asset tree, select the file you wish to update, and then click **Edit**.
2. Click the **Browse** button in the “Upload” section and select the file from your hard drive.
3. Click **Submit**. The file you selected in the system will be overwritten with the file selected.

7.2. Edit an Image

The image editor allows basic image manipulation operations without requiring any additional software. Once you have uploaded an image into Cascade Server, you can perform edits to that image. Specifics about the image editor are listed below:

<table>
<thead>
<tr>
<th>Available Actions</th>
<th>• Resize dimensions (maintaining aspect ratio or not)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Rotate clockwise/counterclockwise</td>
</tr>
<tr>
<td></td>
<td>• Flip horizontal/vertical</td>
</tr>
<tr>
<td></td>
<td>• Crop</td>
</tr>
<tr>
<td></td>
<td>• Undo/Redo</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Applicable File Types</th>
<th>• .jpg</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• .jpeg</td>
</tr>
<tr>
<td></td>
<td>• .png</td>
</tr>
<tr>
<td></td>
<td>• .bmp</td>
</tr>
<tr>
<td></td>
<td>• .gif</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Supported Web Browsers</th>
<th>• Microsoft Internet Explorer 7+</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Mozilla Firefox 3.5+</td>
</tr>
<tr>
<td></td>
<td>• Google Chrome 10+</td>
</tr>
</tbody>
</table>

Below are instructions for using the image editor.
1. Begin editing the image by performing one of the following actions below:

   a) **Upload a New Image and Edit**
      
      If you want to edit an image when uploading it into Cascade Server for the first time, follow the instructions in Section 7.2 above, Steps 1-5 to upload your image. After performing these steps, the image editor will be displayed (see the screenshot to the right).

   b) **Edit an Existing Image**
      
      If you want to edit an image that already has been uploaded into Cascade Server, navigate to the image you want to edit, and click the **Edit** tab. The image editor will be displayed (see the screenshot to the right).

2. In the image editor, perform the desired action. Each available editing action is listed in detail below:

   **Undo/Redo**
   
   These actions work the same way as other programs. The “Undo” action is only available after performing one of the below actions. The “Redo” action is only available after an “Undo” action is performed.

   **Resizing**
   
   a) Change the width and the height values to resize the image. When you change either of these values, the other value will change proportionally to keep the proper aspect ratio. To disable this feature in order to change each value independently, click the “link” icon in between the two boxes.
   
   b) Click the “Resize” button (to the right of the “Height” box) to apply your changes.

   **Rotate**
   
   Change the orientation of the image clockwise or counterclockwise.

   **Flip**
   
   Flip the image like a mirror, vertically or horizontally.

   **Crop**
   
   Remove unwanted parts of the image.
   
   a) Place your mouse cursor inside of the image, and click and drag to select the area of the image you want to keep. The selected area will be highlighted (see the screenshot to the right). To change the size of the selection, use the box “handles” to drag the selection.
   
   b) Click the “Crop” button (red arrow in the screenshot to the right).

3. Click the **Submit** button at the bottom of the page to save your changes.

4. **Publish** your updated image. See Section 3.1 above for instructions.
7.3.  Copy Assets

7.3.1.  Copy a Single Asset
1. While viewing the asset, click the **Copy** tab.
2. Change the file name (in the “System Name” field) if desired.
3. Select the parent (destination) folder, and then click **Submit**.

7.3.2.  Copy Multiple Assets
1. Select the folder containing the assets you want to copy. A detailed list of those assets will be displayed.
2. Select the assets you want to copy by checking the boxes of those assets.
3. In the “With Selected” drop-down menu, select **Copy**.
4. Select the parent (destination) folder, and then click **Submit**.

7.3.3.  Publishing After Copying Assets
After copying your assets, you must publish any pages containing navigation affected by the change. For publishing instructions, see Section 3 above.

7.4.  Move Assets
Before moving an asset, it’s a good practice to remove the asset from your Web site first to ensure that the old asset no longer exists. To move a page, file, or folder to another location within Cascade Server:

7.4.1.  Move a Single Asset
1. Un-publish the asset first. See Section 3.5 above for instructions.
2. Once the asset has been Un-published, while viewing the asset, click the **Move/Rename** tab.
3. Change the file name (in the “System Name” field) if desired.
4. Select the parent (destination) folder, and then click **Submit**.

7.4.2.  Move Multiple Assets
1. Un-publish the asset first. See Section 3.5 above for instructions.
2. Select the folder containing the assets you want to move. A detailed list of those assets will be displayed.
3. Select the assets you want to move by checking the boxes of those assets.
4. In the “With Selected” drop-down menu, select **Move**.
5. Select the parent (destination) folder, and then click **Submit**.
7.4.3. Publishing After Moving Assets

After moving your assets, you must publish any pages containing navigation affected by the change. You must also publish any pages that are linked to those assets. For publishing instructions, see Section 3 above.

To determine if any of the pages you just moved are linked to from another page, do the following:

1. Select the desired page, and click the More tab, and then Delete.
2. If the “Relationships” group appears (see the screenshot to the right), and then you have other pages that are linked to this page. Take note of the pages in the “Relationships” list.
3. Click the Cancel button to stop deleting the page.
   **NOTE:** Do not click the Submit button. If you do, this asset will be deleted.
4. Publish each one of those pages you took note of in Step #2.

7.5. Delete Assets

In order to properly delete an asset, follow these instructions:

7.5.1. Delete a Single Asset

The first step will be to delete the asset from Cascade Server while removing the asset from your published Web site. Then, you will need to publish any affected assets (if applicable).

1. While viewing the asset, and then click the More tab, and then Delete.
2. In the “Un-publish” section, check the box next to “Un-publish Content”. See the red circled area in the example to the right.
3. If the asset you are attempting to delete is linked to from other assets within Cascade Server, the “Relationships” section will appear. This section informs you that the listed assets contain links that will be broken once you delete the current page, and will need to be fixed. Once you have completed deleting this page, you will need to go to the listed assets and fix the broken links.
4. Click Submit. The asset will be deleted from Cascade Server and from your Web site.
7.5.2. Delete Multiple Assets

1. Select the folder containing the assets you want to delete. A detailed list of those assets will be displayed.

2. Select the assets you want to delete by checking the boxes of those assets.

3. In the “With Selected” drop-down menu, select Delete.

4. In the “Un-publish” section, check the box next to “Un-publish Content”.

5. Click Submit. The asset will be deleted from Cascade Server and from your Web site.

7.5.3. Publishing After Deleting Assets

After deleting your assets, you must publish any pages containing navigation affected by the change. You must also publish any pages that are linked to those assets. For publishing instructions, see Section 3 above.

7.5.4. Recover Deleted Assets

When you delete any asset, it will be stored in the Recycle Bin. See Section 10 below for more details.

7.6. Rename an Asset

To change the file name of a page, file, or folder, do the following:

1. While viewing the asset, click the Move/Rename tab.

2. Change the “System Name” field to the desired file name. **NOTE:** If you are renaming a page, do not add an extension (i.e. “.html”). If you are renaming a file, you must keep the extension (“.pdf,” “.gif,” “.jpg”, etc.).

7.6.1. Publishing After Renaming Assets

After renaming your assets, you must publish any pages containing navigation affected by the change. You must also publish any pages that are linked to those assets. For publishing instructions, see Section 3 above.

To determine if any of the pages you just renamed are linked to from another page, do the following:

1. Select the desired page, and click the More tab, and then Delete.

2. If the “Relationships” group appears (see the screenshot to the right), and then you have other pages that are linked to this page. Take note of the pages in the “Relationships” list.

3. Click the Cancel button to stop deleting the page. **NOTE:** Do not click the Submit button. If you do, this asset will be deleted.

4. Publish each one of those pages you took note of in Step #2.
7.7. **Deactivate / Activate an Asset**

In some cases, you will want to temporarily remove a page from your site’s navigational structure, or deactivate a file, enabling them to be available to be reactivated later. You will need to un-publish the page, and then turn it off. When you are ready to reactivate it, you will need to turn it back on. To do this:

1. Navigate to the asset that you wish to deactivate/activate, and then click the **Edit** button.
2. Follow the instructions in Section 3.5 above to un-publish the asset.
3. Click on the **System** link in the dark blue bar just below the “Edit” tab.
4. Uncheck the boxes for “Include when Publishing” and “Include when Indexing”. This will prevent the asset from being published, and remove all navigational items (if applicable), leaving your asset in Cascade Server for later use.
5. Click the **Submit** button to save your page.
6. You must publish any pages containing navigation affected by the change. For publishing instructions, see Section 3 above.

7. **To activate the asset:** Follow the steps above and check the “Include when Publishing” and “Include when Indexing” checkboxes in Step 4. You must publish any pages containing navigation affected by the change. For publishing instructions, see Section 3 above.

8. **MANAGE NAVIGATION AREAS**

The navigation areas of your Web site are automatically built by Cascade Server, but there are several actions you can take to manipulate these areas.

8.1. **Add a Link**

A “Link” in Cascade Server is a way to add an item to your navigation that links the user to another section in your current site, or to an external Web site. For example, say you wanted to link a user to the “Contact Us” section from the “Customer Center” section of your site.

To accomplish this, you would add a link called “Contact Us” into the “Customer Center” folder, which links to the “Contact Us” section. This link would then be displayed in your navigation. When the user clicks on “Contact Us” in the left navigation of “Customer Center”, they will be taken out directly to the “Customer Center” section. Likewise, you can add a link into your navigation that links to an external Web site.

To add a link to another asset within your site, or to add a link to an external Web site, follow the instructions below.
To add a link to your navigation:

1. In the Asset Tree on the left, navigate to the folder you wish to add the link to

2. In the top blue navigation bar, click on **New**, and then click **Navigation Link**.

3. Type in a Display Name for your link. Remember, the Display Name will be displayed in the navigation.

4. Scroll down to find the “Navigation Link” section, then choose **one** of the options below:

   **To Link to a Page in Cascade Server:**
   
   a) In the “Link to Page” section, click on the browse icon in the “Select Page” field. Another window will open, and you will see your Asset Tree on the left side.

   b) Find the page you would like to link to by selecting folders on the asset tree on the left, and clicking on the asset.

   c) Click **Confirm**. The window will close, and the “Select Page” field will show the selected page’s path.

   d) Proceed to Step 5 below.

   **To Link to a File in Cascade Server:**
   
   a) In the “OR Link to File” section, click on the browse icon in the “Select File field. Another window will open, and you will see your Asset Tree on the left side.

   b) Find the file you would like to link to by selecting folders on the asset tree on the left, and clicking on the asset.

   c) Click **Confirm**. The window will close, and the “Select File” field will show the selected file’s path.

   d) Proceed to Step 5 below.

   **To Link to an External Web Site:**
   
   a) In the “OR Link to External Web Site” section, type in the Web address (URL) of the site you wish to link to (e.g. [http://www.beacontechnologies.com/](http://www.beacontechnologies.com/)) into the “URL” field.

   **NOTE:** Ensure that your link starts with `http://`. Otherwise, the link will be broken.

   b) By default, this link will open in a new browser window. If you do not want it to open in a new window, select **Same Window** in the “Target” field.

   c) Proceed to Step 5 below.

5. Click **Submit** to save the link. Follow the instructions in Section 8.2 below to sort your new link in the navigation, and Section 3 to publish your new link.
8.2. Sort

The links in the navigation areas can be sorted easily. While looking at a folder’s detail view (Section 6.1 above), you can click on the “Order” column to display the sort order for that folder’s assets. To sort how your assets appear in your site’s navigation:

1. Click on the desired folder in the left asset tree containing the assets you want to sort.
2. If your assets are not listed in ascending order in the “Order” column, click the “Order” column heading.
3. Place your mouse anywhere on the line of the asset you wish to move. Your mouse pointer will change to 
   (If your mouse pointer does not change, move horizontally along the asset’s line until it does).
4. Click and hold your left mouse button, and then drag the asset up and down to the desired position.
5. Release your left mouse button. The sort order will change automatically.
6. After sorting your assets, you must publish any pages containing navigation affected by the change. For publishing instructions, see Section 3 above.

8.3. Remove a Link

It is possible to have a page on your site that is not listed in your navigational menus. This is useful if you have a page that you just want to link to, but don’t necessarily want listed in your left navigation menu or your top navigation drop-down menus. To accomplish this:

1. Go into Edit mode for the page you wish to remove from your site’s navigational menus.
2. In the “Inline Metadata” section, select “No” in the “Display in Navigation?” field.
3. Click Submit.
4. You must publish any pages containing navigation affected by the change. For publishing instructions, see Section 3 above.
9. **VERSIONS**

Cascade Server keeps the last 25 versions of your assets, allowing you to restore a previous version of your page. This is especially useful if you make several modifications and need to back them out.

⚠️ **NOTE:** Any asset (except folders) can be rolled back to a previous version.

### 9.1. Restore Previous Version

To preview and restore a previous version of an asset:

1. Navigate to the asset that you wish to change the version for.

2. In the Asset Action Toolbar, click the “More” tab, and then click **Versions**. This will bring up a list of all available versions of your asset. Listed is the path of the asset, the date of the version, who modified it, and any comments that the user entered.

3. Choose the asset version you wish to restore by clicking the asset’s path in the “Path” column.

4. Cascade Server displays the selected version, along with a list of options called “Viewing”. You can perform the following actions with these options:

   - **Newer:** Displays the next newer version of the selected asset.
   - **Older:** Displays the next oldest version of the selected asset.
   - **Current:** Displays the current version of the asset.
   - **Activate:** Selecting this option will make the selected version the current version. By doing so, the previous current version will become the next-latest version.
   - **Delete:** If you are certain that the selected version will never be needed, you can select this option to remove it. See Section 9.2 below for more information.
   - **Compare with Current:** Allows you to merge the current version and the selected version together, displaying what the differences are between the two versions. This is similar to Microsoft Word’s “Track Changes” function. ⚠️ **NOTE:** This works for pages only.

5. Once you choose the version you want to restore, select **Activate**. The selected version will be implemented.

6. **Publish** the asset. See Section 3 above for instructions.

### 9.2. Delete Versions

You have the ability to delete unwanted versions in order to keep the number of versions below 25. To do this:

1. Select the asset in which you wish to delete the previous versions.

2. In the Asset Action Toolbar, click the **Versions** tab. This will bring up a list of all available versions of your asset. Next to each previous version is a checkbox.

3. Check each version that you wish to delete.

4. At the bottom of the page, in the “With Selected” drop-down box, select “Delete”.
10. **RECYCLE BIN**

Cascade Server’s Recycle Bin is a temporary holding area for deleted assets which helps prevent loss of content. Assets in the Recycle Bin can be restored to their original location. For instructions on deleting assets, see Section 7.5 above.

**How long do deleted assets stay in the Recycle Bin?**

Assets that are deleted will remain in the Recycle Bin for 30 days, and then be permanently deleted.

**What is sent to the Recycle Bin?**

All assets (pages, files, folders) are sent to the Recycle Bin when deleted. Once in the Recycle Bin, the assets can be restored to their original location (see below), or they will be permanently deleted after 30 days.

**Accessing the Recycle Bin**

To access the Recycle Bin, click the link on the Dashboard or the link in Quick Links. See the screenshot to the right.

**Restoring Assets**

To restore an individual asset back to its original location, click the green **Restore** icon in the **Actions** column. See the screenshot to the right.

To restore multiple assets, select the assets using the checkboxes in the left column. Then click the "With Selected:" dropdown menu, and select **Restore**.
11. **USABILITY GUIDELINES**

When editing your own content, maintaining a consistent look and feel across all pages is vital for your site’s visitors. Here are some guidelines for good usability practices.

- **Use consistent font types.** If your site uses an Arial font, you should only use Arial in your content.

- **Use consistent colors.** Try to keep any colors consistent with your site’s color scheme.

- **Resize your images using a graphics program.** Don’t put large images in your content. You will want to scale them down as to not overwhelm the user and push your text to the bottom of the page.

- **Don’t overuse bolding, italics, or capitalization.** Bolding, italics, and capitalization are both used for emphasizing a word or a sentence. Bolding or italicizing an entire paragraph or page, or capitalizing a headline or title, can detract from the look of your content and make it difficult to read.

- **Use consistent font sizes.** Try not to use very large font sizes. Use the same font size for a heading that is used on another page in order to keep a consistent look.

- **Format bullets or numbered lists.** Always left-align bulleted or numbered lists. Centering these can confuse the user and make it hard for them to read down the list.

- **Always left-align paragraphs.** For a paragraph of text, you will always want to left-align the text. Centering or right-aligning will make the text more difficult to read.

- **Right-align labels.** If you are creating a label followed by a colon, right-align the labels and bold them. For example:

  Your Name:  Joe Smith

- **Keep it professional.** Use the same standards that you would use when creating a document in a word processor.
12. **STANDARD PAGE FEATURES**

To edit the content of a Standard Page, click the Edit tab of the page you wish to edit, and then follow the instructions below. Other types of pages are discussed later.

### 12.1. Inline Metadata

The “Inline Metadata” group contains the following fields:

- **Display Name**: The title that is displayed in the top and left navigation areas.
- **Title**: The title that is displayed above the content area.
- **Include in Navigation?**: Determines whether this page will be displayed in the left navigation.

### 12.2. Content

The content area (the “Content” group) contains the main content of the page. See Section 2.2 above for instructions on using the content editor.

#### 12.2.1. Maximum Image Width

With the right column enabled (see Section 12.5 below), the content area width changes. Thus, the maximum width for an image depends on whether you’re using a 2-column or a 3-column layout.

Here are the required sizes:

- **2-Column Layout**: No wider than 470 pixels;
- **3-Column Layout**: no wider than 705 pixels

Each of these dimensions is indicated by dashed lines in the content editor (see screenshot above).

#### 12.2.2. Maximum Table Width

The maximum table width will depend on the same factors as images above. However, when creating a table, in order to maintain Section 508 Compliance, table widths should be entered in percentages.
12.3. Impact Image

Your site allows you to display an impact image on each page, which will appear just above the page’s content area. This image is optional, and if not displayed, the content will slide up to take its place. See the screenshot to the right for the placement of the image.

You can control which image appears on each page by doing the following:

1. Navigate to the desired page, and then click Edit. Scroll down to find the “Content Region” group.

2. In the “Impact Image” field, click on the image icon to open the image selector, and select the desired image. Note the required size, which can be viewed by hovering your mouse over the Help icon.

3. If you want to remove an image from a page, in the “Impact Image” field, click the “Cancel” icon. The selection will be removed.

4. Click Submit to save the page.

5. To Publish: Publish the current page. See Section 3.1 above.

12.4. Left Column (Contact Information)

The left column contains an optional section of content called “Contact Information”. This section will display a title (“Contact Information”), a department’s name, phone number, address, and an individual’s contact information (name, title, and email). See the screenshot to the right for the placement of this region.

This region can be controlled by one of two methods:

- By default, all pages will display the Contact Information content from the section’s homepage (“index”). See Section 12.4.1 below.
- Within a section’s subsections, you can override the default settings and display different content. See Section 12.4.2 below.

By default, all pages will display the Contact Information content from the section’s homepage (“index”). In other words, if you set the content on the section’s homepage, all of the pages in that section will display the same content.
12.4.1. Set Section’s Default Content

To set the section’s default content:

1. Navigate to the section’s homepage (e.g. /about/index), and then click Edit.
2. Scroll down to find the “Left Column >> Contact Information” group.
3. In the “Display Settings” field, select “Set Content Below as Section Default”.
4. Enter the Department Name, Department Phone, and Department Address information.
5. Click on the “Left Column » Contact Information » Contact Person” blue title to expand it.
6. Fill out the information listed.
7. Click Submit to save the page. All pages within this section will now display the content you just entered.
8. To Publish: This content update affected all pages within this section. Therefore, you will need to publish the entire section. See Section 3.3.

12.4.2. Change Subsection’s Content

By default, all pages will display the Contact Information content from the section’s homepage (“index”) set in Section 12.4.1 above. However, you can override this content on any subsequent subsection. To override this content, edit the desired subsection’s “index” page by following the instructions in Section 12.4.1 above.

12.4.3. Hide Content

If you do not want the Contact Information section to display in a section, follow the instructions in Section 12.4.1 above, Steps 1-2. For Step #3, select “Do Not Display”, and then follow Steps 6-7.

12.5. Right Column

Your site allows you to display a right column, which will appear to the right of the page’s content area. This right column is optional, and if not displayed, the content will slide over to take its place. See the screenshot to the right for the placement of the right column.

The right column allows for you to add one or multiple blocks of content. You can also set the grey title bar’s value.

You can control the content of the right column on each page by doing the following:
1. Navigate to the desired page, and then click **Edit**. Scroll down to find the “Right Column” group. Click on this blue title to expand it.

2. In the “Display” field, ensure that “Yes” is selected. This will ensure that your page is displayed in a 3-column layout.

3. In the “Title” field, enter the desired title that will appear in the grey bar at the top of the right column.

4. In the “Right Column >> Content Block” section, enter the desired content into the content editor. **NOTE:** The content editor does not show the correct width of the right column. Thus, you will need to keep in mind that any image or table inserted into this area must be 200 pixels wide. There is no restriction on height, however.

5. To add, sort, or remove a content block on this page:
   - **To Add a Content Block:** Find the “Right Column >> Content Block” section that you want to add the new content block AFTER, then click the □ icon.
   - **To Remove a Content Block:** Find the “Right Column >> Content Block” that you want to remove, and click the ▼ icon.
   - **To Sort the Content Blocks:** Find the “Right Column >> Content Block” that you want to move up or down in the list, then click the ▲ or ▼ icon.

6. Click **Submit** to save the page.

7. To publish your changes, publish the current page. See Section 3.1 above.

### 13. Faculty Profiles

The Faculty Profiles section allows a Cascade Server user to create a page containing biographical information for each faculty or staff member. A listing page containing all faculty and staff is automatically created by Cascade Server based on these created pages. There are two listing pages: alphabetical, and by department.

The profiles and listing pages are located in the following folders:

- All Profiles: /faculty-staff/profiles/
- Alphabetical Listing: /faculty-staff/index
- Departmental Listing: /faculty-staff/department
13.1. Add a Profile

To add a new profile:

1. In the blue top navigation bar, select New > Faculty Profile.

2. In the “System Name” field, replace the default value of “profile” with the desired file name of this page.
   **NOTES:**
   - Do not add a file extension (e.g. “.html”). For example, if you are adding a file called “john-smith.html”, you will want to just type in “john-smith”.
   - Do not put spaces in your file name. Instead of spaces, use hyphens.
   - Use all lowercase letters.
   - The “System Name” value should be short, and is not the page’s title.
   - Suggestion: “john-smith”

3. In the “Inline Metadata” section, fill in the requested information.

4. In the “Faculty Profile” section, in the “Photo” field, click on the image icon to open the image selector, and select the desired image. Note the required size, which can be viewed by hovering over the Help icon.

5. Enter the desired biographical text into the “Content” content editor.

6. Click Submit to save the page.

7. To Publish: You will need to publish the following assets:
   - The page you just created
   - Both listing pages (see the Section 7 introduction above for their locations)

13.2. Edit a Profile

To edit an existing profile:

1. Find the page you want to edit within the “/faculty-staff/profiles” folder, and click Edit.

2. Make the desired changes to the page, then click Submit to save the page.

3. To Publish: You will need to publish the following assets:
   - The page you just edited
   - Both listing pages (see the Section 7 introduction above for their locations)

13.3. Delete a Profile

To delete a profile:

1. Follow the instructions in Section 7.5.1 above to properly delete the page.

2. To Publish: You will need to publish the following assets:
   - Both listing pages (see the Section 7 introduction above for their locations)
13.4. Maintain Departments Dropdown Menu (Administrators Only)

Each profile contains a dropdown menu listing the available departments to choose from. Based on the department selection the department on the profile page and the listing pages are automatically linked to the appropriate department’s landing page. This list must be properly maintained in order to function properly.

13.4.1. Add a Department

To add a department to the dropdown menu:

1. In the blue top navigation bar, go to Administration > Metadata Sets. Click on “Faculty Profile”.

2. Click the Edit tab, and then click Dynamic Fields in the dark blue bar, just below the tabs. Scroll down to find the “Department” field.

3. In the “Configuration” field, you will need to type in the following syntax, or copy an existing line:

```xml
<item>Department</item>
```

**NOTES:**
- The blue text will be what is displayed in the faculty profile’s “Department” dropdown menu.
- The order you list the <item> tags here will determine the order in the dropdown menu.
- To modify or delete a department, see the appropriate sections below.
- Take note of the exact department name you used, as this is needed later.

4. When you are done, scroll to the bottom and click the Submit button to save the Metadata Set.

5. Next, you will need to change the XSLT format that automatically populates the department links. Go back to the Home section of Cascade Server by clicking on Home in the blue top navigation bar. Then, find the new department’s landing page within Cascade Server and click on it. Take note of the exact path of the asset, which is listed above the tabs. See the screenshot to the right. In this example, it’s /geography/index.

6. Navigate to the following file, and then click the Edit tab:

```
/_internal/formats/faculty profile/departments
```

7. Scroll down to find the line that contains the following comment:

```
<!-- **** BEGIN: Department Link Function ****--> 
```

8. Just below this line, you will see a listing of departments. You will need to copy and existing line:

```xml
<xsl:when test="dynamic-metadata[name='dept']/value = 'Department'"/>
```

**NOTES:**
- The blue text needs to exactly match the blue text from Step 3 above.
- The maroon text needs to exactly match the department’s landing page path from Step 5.

9. Click the Submit button to save the format.

10. The new department will now be available when creating or editing a profile page. At this time, no publishing is needed.
13.4.2. Edit / Delete a Department

Editing or deleting a department’s name in the “Department” dropdown menu is not recommended. If you change a department’s name, any faculty profile page with that department selected will lose that selection. Thus, you will need to edit each profile page and re-select the appropriate department. However, if it is necessary to rename or delete a department, do the following:

1. Follow the instructions in Section 13.4.1 above.
   - **If Renaming:** In Step 8, simply change the department name (blue text).
   - **If Deleting:** Instead of adding lines of code in Steps 3 and 8, delete those lines of code.

2. Edit each profile page that had the department selected, and select a new department name.

3. **To Publish:** You will need to publish the entire “/faculty-profile” folder in order to update both listing pages and all affected faculty profile pages.

14. **TOP-LEVEL FOLDERS (Administrators Only)**

The “Top-Level Folder” is a folder located at the root level of the site. Each of these folders allows you to specify the title of the section, as well as the associated college, which controls the colored name of the college on the right side of the header. To create a new top-level folder:

1. In the left asset tree, click on **Base Folder** at the top of the folder tree. Then in the blue top navigation bar, click **New > Top-Level Folder**.

2. Enter the desired title for the section into the “Display Name” and “Title” fields.

3. In the “College” field, select the associated department. Note that “General” is selected by default. To maintain the list of colleges, see Section 15.1.1 below.

4. Click **Submit** to save the folder.

5. In the left asset folder tree, click on the new folder that was created in Step 5 above.

6. Following the instructions in Section 2 above, edit the “index” page’s Display Name, Title, and Content. **NOTE:** This page **must** remain in this folder, and cannot be renamed (it must keep a System Name of “index”) in order for your navigation work properly. This page can contain any Display Name, Title, and content that you wish, and will be the page that a Web site visitor lands on when entering this section.

7. In this new folder, follow the steps in Section 4 above to create your new pages, and sort your pages as desired (see Section 8.2 above for sorting instructions).
15. **HEADER / FOOTER (ADMINISTRATORS ONLY)**

15.1. Header

The HTML for the header is contained within three regions. Two of the three regions are include files, and the other region (the department “drape”) is not in an include file. When editing each of the three regions of the header, you will need to then publish different assets. The table below explains where the code for each region is located, and what you need to publish when making changes:

<table>
<thead>
<tr>
<th>HTML Location</th>
<th>Publish</th>
</tr>
</thead>
<tbody>
<tr>
<td>/_internal/formats/header</td>
<td>/includes-cms/header</td>
</tr>
<tr>
<td>/_internal/formats/header-topnav</td>
<td>/includes-cms/header-topnav</td>
</tr>
<tr>
<td>/_internal/formats/header-department</td>
<td>Entire Site</td>
</tr>
</tbody>
</table>

The “header-department” format contains the code for changing the college name/color in the right-hand corner of the header. This code looks at each top level folder (see Section 3 above) to determine which college is set for the section, and displays the proper text/color. To make changes to this code in order to add, edit, or delete colleges:

15.1.1. **Add a College**

To add a college, you must first add your new CSS class to your CSS file, and then do the following:

1. In the blue top navigation bar, go to Administration > Metadata Sets. Click on “Top-Level Folder”.
2. Click the Edit tab, and then click Dynamic Fields in the dark blue bar, just below the tabs. Scroll down to find the “College” field.
3. In the “Configuration” field, you will need to type in the following syntax, or copy an existing line:
   ```html
   <item>College</item>
   ```
   **NOTES:**
   - The blue text will be what is displayed in the top-level folder’s “College” dropdown menu.
   - The order you list the <item> tags here will determine the order in the dropdown menu.
   - To modify or delete a college, see the appropriate sections below.
   - Take note of the exact college name you used, as this is needed later.
4. When you are done, scroll to the bottom and click the Submit button to save the Metadata Set.
5. Navigate to the following file, and then click the Edit tab: /_internal/formats/header-department
6. Scroll down to find the line that contains the following comment:
   ```html
   <!--// **** BEGIN: College Display Function ****//-->
   ```
7. Just below this line, you will see a listing of departments. You will need to type in the following syntax, or copy and existing line:

```
<xsl:when test="//system-page[@current='true']/ancestor::system-folder/dynamic-metadata[name='department']/value = 'College'">
  <xsl:attribute name="class">css-class</xsl:attribute>
</xsl:when>
```

⚠️ **NOTES:**
- The **blue** text needs to **exactly** match the **blue** text from Step 3 above.
- The **maroon** text needs to **exactly** match the desired CSS class.

8. Click the **Submit** button to save the format.

9. The new department will now be available when creating or editing a top-level folder. At this time, no publishing is needed.

**15.1.2. Edit / Delete a College**

Editing or deleting a college's name in the “College” dropdown menu is not recommended. If you change a college’s name, any top-level folder with that college selected will lose that selection. Thus, you will need to edit each folder and re-select the appropriate college. However, if it is necessary to rename or delete a college, do the following:

1. Follow the instructions in Section 15.1.1 above.
   - If Renaming: In Step 8, simply change the college name (**blue** text).
   - If Deleting: Instead of adding lines of code in Steps 3 and 8, delete those lines of code.

2. Edit each folder that had the department selected, and select a new college name.

3. **To Publish:** You will need to publish each folder you edited in Step 2.

**15.2. Footer**

The HTML for the header is located here:

```
/_internal/formats/footer
```

When making any changes to the footer, you must publish the entire site (Section 3.4 above).